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1 Introduction

Bluegiga SDK is based on Yocto project build system. Yocto offers powerful tools for cross compiling and
debugging embedded applications and is also used to prepare custom distributions, like the one used as the
default for the APx4. Yocto build system is very flexible and it is delivered with hundreds of open source
applications.

1.1 Glossary

Bitbake is the application cooker. It handles package dependencies and executes build commands.

Recipe contains building instructions for bitbake. It has information about url of source code package, rules of
compiling and package dependencies. All applications have their own recipes.

Layer is a Yocto term to indicate a set of recipes and configuration files. Recipes are divided into different layers
such as board support and distribution meta layers.

.bpk indicates Bluegiga package format. It can contain complete filesystem images for the APx4 or scripts that
are run when the package is installed.

Reflash is a term used in the name of special .bpk packages containing full file system images. A *reflash*.bpk
can be installed using the web interface or by other ways, for example by uploading it to the /tmp/autoinstall
directory.

.ipk is a package format used by the OPKG package management system.
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1.2 SDK directory layout

+- bl uegi ga- sdk

+-build
f ol der
| +-conf

sel ected here

sel ected here
| +tnp
[ +- depl oy
| | +-images
after building
[ | +ipk
i nto subfol ders
| | +-al |

| +- wor k
+- conf

+- downl oads
+- sst at e-cache

conmmand

| | +-1ocal.conf

| | +-bblayers. conf bi t bake | ayer config file, neta layers are

| | +-arnvbte
| | +- apx4devki t

built and packaged

+-i mages | ocation for pre-built file systemimges and
u- boot binaries

+-neta neta | ayers for Bluegiga SDK

| +-bluegiga-bsp | ayer which provi des apx4 hardware support

| +-bluegiga-distro | ayer containi ng open source applications

| +-bluegiga-binary-utils layer with Bluegiga closed source applications

| +-bl uegi ga- exanpl es | ayer that contains exanple applications

+-yocto | ocation for Yocto neta |layers and bitbake

build folder, bitbake command is executed in this

| ocal configuration file, e.g. target machine is

file systemimages and u-boot binaries are here

| ocation for ipk packages, packages are divided

work directory where applications are patched,

tenplates for local.conf and bbl ayers.conf files
source file downl oad cache
sstate cache (pre-conpiled binaries)

1.3 Meta layers

Bluegiga SDK contains following meta layers.

yocto/meta
meta/bluegiga-bsp
meta/bluegiga-distro

meta/bluegiga-binary-utils

meta/bluegiga-examples

Recipes from Yocto
Bluegiga hardware Board Support Package (BSP) for apx4devkit

Bluegiga Linux distribution related recipes (add-on software on top of Yocto base
installation)

Bluegiga utils and helper applications

Bluegiga example applications

Yocto is base of whole SDK and all other layers are depending on it. Following figure shows all layers and their

dependencies.
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Bluegiga Utils Bluegiga Examples

Bluegiga Distro

Bluegiga BSP

Yocto

1.4 Other interesting links

® Yocto documentation: http://www.yoctoproject.org/documentation

®* New Developer Screencast Tutorial by Yocto:
http://www.yoctoproject.org/blogs/jeff/2012/new-yocto-project-introductory-screencast

® Frequently asked questions: https://wiki.yoctoproject.org/wiki/FAQ

1.5 Sources for recipes

If you want to use an application but did find it from the prebuild packages, please look for below source of
recipes. The sources are listed in an order where the recipes found from the first ones are most likely to compile
without modifications. The recipes found from the links that are further down are more likely to require some
tuning before they work.

1. oe-core, yocto is fetching data from this repository:
http://git.openembedded.org/openembedded-core/tree/

2. (these should be fully compatible with latest yocto)
http://git.openembedded.org/meta-openembedded/tree/

3. (tens of community driven meta layers)
http://www.openembedded.org/wiki/Layerindex

4. (deprecated openembedded classic, these recipes are not fully compatible)
http://git.openembedded.org/openembedded/tree/
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2 Getting started

Bluegiga SDK is tested to work with Ubuntu 12.04 LTS. Separate SDK packages are delivered for 32-bit and
64-bit host operating systems. (64-bit version not yet available at the time of writing, but 32-bit SDK can be used
in 64-bit OS installations.)

2.1 System requirements

Ubuntu 12.04 LTS (other Ubuntu distributions should work as well)
10 GB of free hard disk space

2 GB of RAM

Internet access

In order to check the Ubuntu version, use the following command:

..............................................................................................................................................................................

~$ Isb_release -a

No LSB nodul es are avail abl e.
Distributor ID: Ubuntu
Description: Ubuntu 12.04 LTS
Rel ease: 12.04

Codenane: precise

..............................................................................................................................................................................

~$ unane -a
Li nux csteam Thi nkPad- Z60m 3. 0. 0- 16- generi c #29-Ubuntu SMP Tue Feb 14 12:49: 42
UTC 2012 i 686 i 686 i 386 GNU Li nux

..............................................................................................................................................................................

..............................................................................................................................................................................

~$ df -h

Fil esystem Size Used Avail Use% Mounted on
/ dev/ sdal 90G 9.8G 76G 12%/

udev 996M 4.0K 996M 1%/ dev

tnpfs 401M 788K 401M 1% /run

none 5.0M 0 5.0M 0%/run/lock
none 1003M 200K 1003M 1% /run/shm

~$ free -m

t ot al used free shar ed buffers cached
Mem 7985 5352 2633 0 152 1346
-/ + buffers/cache: 3852 4133
Swap: 8188 0 8188
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2.2 Installing the SDK

The SDK installation is a fairly straightforward process and requires only a few steps. This section walks you
through the SDK installation and compilation of your first Re-flash packet.

g System wide root (or sudo) access is required to do some of the installation steps.

2.2.1 Step 1: Install required packages

Bluegiga SDK requires some additional packages in order to work properly. Packages can be installed running
the following commands.

$ sudo apt-get update

$ sudo apt-get install sed wget cvs subversion git-core coreutils \
unzi p texi 2htm texinfo libsdl1.2-dev dochook-utils gawk \
pyt hon-pysqglite2 diffstat hel p2man nmake gcc buil d-essential \
g++ desktop-file-utils chrpath |ibgl1-nesa-dev |ibglul-nesa-dev \
nmercurial autoconf automake groff

The command above will require the download of about 550-650MB (depending on the Ubuntu installation) from
the Internet and this will take a while depending on your Internet connection speed.

! You will be asked if you want to download the packages from the Internet and you need to answer "Yes" to the question.

2.2.2 Step 2: Extract the SDK package

After the compressed archive containing the SDK files is received from Bluegiga and is copied to the local file
system, you will have to extract its contents into your home directory by running the following commands:

$ cd ~/
$ tar xvf /path/to/bluegi ga-sdk-sstate_5.0.0-beta2_apx4devkit.tgz

1 Before uncompressing the archive, make sure once again that there is enough space under your home directory with
command df -h

2.2.3 Step 3: Start building

First you need to prepare the necessary environment variables and create a build folder. You can do this by
running the script source init-sdk-env as seen in the example below (after this command is executed, the
current directory will be changed to ~/bluegiga-sdk/build which is the directory where bitbake must be run
always.)

Then you can experiment building your first reflash package with Yocto's command called bitbake. Example
ready target recipes are bluegiga-console-image (to obtain a full installable filesystem, like the one installed by
default in APx4s, using recipes from all meta layers as from graph in chapter 1.3) or bluegiga-base-image (to
obtain a minimal distribution spanning only meta layers Yocto, Bluegiga BSP and a reduced Bluegiga Distro.) By
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default bitbake will search for the given recipe in all meta layers directories defined
in ~/bluegiga-sdk/build/conf/bblayers.conf and for example the bluegiga-console-image happens to be under
~/bluegiga-sdk/meta/bluegiga-distro/recipes-image/bluegiga/

1. Building a Reflash package should take less than 15 minutes with a quad core CPU with 4 GB of RAM, but please keep in
mind that it might take a lot longer with older machines.

Example:

$ cd ~/ bl uegi ga- sdk
$ source init-sdk-env
$ bi t bake bl uegi ga-consol e-i nage

A successful build operation will deliver the following output:

Pseudo is not present but is required, building this first before the main
build

Par si ng reci pes: 100% | ####H#H##HHHARHHHHHHHH TR HHH T T me:

00: 00: 53

Parsing of 883 .bb files conplete (0 cached, 883 parsed). 1162 targets, 38
ski pped, 0 nasked, O errors.

NOTE: package bl uegi ga-consol e-i mage-1.0-r0: task do_rootfs: Started
NOTE: package bl uegi ga-consol e-i mage-1.0-r0: task do_rootfs: Succeeded
NOTE: Runni ng task 1977 of 1978 (ID: 8, /tnp/sdk/bluegiga-sdk/yocto/../netal
bl uegi ga-di stro/ reci pes-refl ash/ bl uegi ga/ bl uegi ga- consol e-refl ash. bb
do_bui l d_reflash)
NOTE: package bl uegi ga-consol e-reflash-1.0-r0: task do_build_reflash: Started
NOTE: package bl uegi ga-consol e-reflash-1.0-r0: task do_build_refl ash
Succeeded
NOTE: Runni ng noexec task 1978 of 1978 (ID: 5,
/t mp/ sdk/ bl uegi ga- sdk/ yocto/ ../ neta/
bl uegi ga-di stro/ reci pes-refl ash/ bl uegi ga/ bl uegi ga- consol e-refl ash. bb
do_bui | d)
NOTE: Tasks Sunmary: Attenpted 1978 tasks of which 1910 didn't need to be
rerun and all succeeded.

After the building tasks are completed the reflash package can be found in the following directory:
~/bluegiga-sdk/build/tmp/deploy/images/
The file itself will be called bluegiga-console-reflash_5.0.0-beta* apx4devkit.bpk and in that same directory also

a symbolic link called bluegiga-console-reflash_apx4devkit.bpk will exist, always pointing to the last compiled
package.
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2.2.4 Step 4: SDK installation completed

Congratulations, you have now successfully installed the Bluegiga APx4 SDK and created your first file system
image delivered in an installable *reflash*.bpk package.

2.2.5 Step 5: Copy Re-flash package to target

You can now install the compiled Re-flash package into the APx4. To install the Re-flash package you could use
SCP application for uploading it into the APx4.

The syntax for copying a file using SCP is

..............................................................................................................................................................................

..............................................................................................................................................................................

The installation of the package starts automatically if it is uploaded to the correct directory, that is,
/tmp/autoinstall/

..............................................................................................................................................................................

$ cd ~/ bl uegi ga- sdk/ bui | d/ t np/ depl oy/ i mages/
$ scp bl uegi ga-consol e-refl ash_5. 0- bet al- 20120328105830_apx4devki t . bpk
root @o0.1.1.127:/tnp/autoinstall/

2.2.6 Troubleshooting

In case the installation of the SDK did not succeed, for example you were not able to compile the reflash
package, please contact Bluegiga technical support for assistance. Include in your request the details of your PC
as well as all installation and error logs.
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3 Compiling and installing Hello World

Applications are compiled and .ipk packages are built by bitbake command. User has to provide the meta data
of the application and a set of building rules for bitbake. These data and rules are written to a text file called a
recipe which file extension is .bb. More information about recipes and bitbake command is available at Bitbake
User Manual and Openembedded User Manual.

3.1 Simple own Hello World application

Bluegiga SDK offers very simple and world famous Hello World application as an example. The application files
are located at ~/bluegiga-sdk/meta/bluegiga-examples/recipes/helloworld/ The Hello World application consists
of a recipe file and a source code file written in C language. Recipe file is named helloworld_1.0.bb where
helloworld is the project name and 1.0 is version of the project.

~/bluegiga-sdk/meta/bluegiga-examples/helloworld/helloworld 1.0.bb

PR = "r1"
LI CENSE = " CLOSED"

S = "${WORKDI R} "
FILES ${PN} = "/"

SRC URI = "file://helloworld.c"

do_conpile() {
${CC} helloworld.c -0 helloworld

}

do_install () {

install -d ${D}${bindir}

install -m 0755 helloworld ${D}${bindir}
}

The recipe contains meta data for the creation of the .ipk package, list of source files and instructions for
compiling binary and building package. Hello world application is then built using bitbake command as shown
below. Remember that the "source init-sdk-env" must always be launched when a new terminal window is
opened.

..............................................................................................................................................................................

" $ cd ~/bl uegi ga- sdk
. $ source init-sdk-env
i $ bitbake helloworld

The ready .ipk package will be copied to
~/bluegiga-sdk/build/tmp/deploy/ipk/armv5te/helloworld_1.0-r1_armv5te.ipk by bitbake.

To install the hello world to your APx4 you have multiple choices:
® Using the web interface -> Software upload
® Using SCP: scp ~/bluegiga-sdk/build/tmp/deploy/ipk/armv5te/helloworld_1.0-r1_armv5te.ipk
root@[APx4 IP address]:/tmp/autoinstall/

Once installed you can run the program at the shell prompt of the APx4: /usr/bin/helloworld where also /usr/bin/
is defined in the recipe (see http://docs.openembedded.org/usermanual/html/directories_installation.html)
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3.2 Autotools-based Hello World application

Bluegiga SDK is designed for building autotools-based applications (see
http://en.wikipedia.org/wiki/lGNU_build_system). User needs only to define meta data and URL of source
package. SDK is capable of handling the rest, like compiling binaries and installing files. A basic example of
autotools based hello workd application is at ~/bluegiga-sdk/meta/bluegiga-examples/helloworld/hello_2.7.bb.

~/bluegiga-sdk/meta/bluegiga-examples/helloworld/hello_2.7.bb

DESCRI PTION = "GNU Hel | owor|l d application”

SECTI ON = "exanpl es"

LI CENSE = "GPLv3"

LI C_ FILES CHKSUM = "fil e:// COPYI NG nd5=d32239bch673463ab874e80d47f ae504"

DEPENDS = "virtual /gettext"”

SRC URI = "http://ftp.gnu.org/ gnu/ ${PN}/ ${PN}-${PV}.tar.gz"

SRC_URI [ md5sun] = "fc01b05c7f943d3c42124942a2a9bb3a"

SRC URI [ sha256sun] =

"fd593b5bcf 6d1bb6d7d1lbb7eef dccdc0010cf 2c4985cch445ef 490f 768b927c0"

i nherit autotools

3.3 More information

More information about writing recipes and using bitbake is available at:

® Yocto Reference Manual: http://www.yoctoproject.org/docs/current/poky-ref-manual/poky-ref-manual.html

® Recipe & Patch Style Guide: https://wiki.yoctoproject.org/wiki/Recipe_%26_Patch_Style_Guide

® OpenEmbedded User Manual (partly outdated but might be very useful):
http://docs.openembedded.org/usermanual/html/
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4 Customizing file system image to include additional programs

If you want to add your own applications, like helloworld and hello into the file system image it is possible to do
so. File system images can be customized adding new packages to IMAGE_INSTALL variable of recipe.

meta/bluegiga-distro/recipes-image/bluegiga/customized-console-image.bb

| MAGE_FEATURES += "bl uegi ga- apps- consol e bl uegi ga- apps- connectivity"
LICENSE = "M T"

i nherit bl uegi ga-imge

| MAGE_I NSTALL += "hell oworl d hell o"

Build customized file system image using bitbake command.

..............................................................................................................................................................................

$ cd ~/ bl uegi ga- sdk
$ source init-sdk-env
$ bi t bake custom zed-consol e-i nage

More information about image customization can be found from documentation of Yocto:
http://www.yoctoproject.org/docs/latest/dev-manual/dev-manual.html#usingpoky-extend-customimage
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5 Configuring Linux kernel

5.1 Enabling features or drivers inside the kernel

To enable features or drivers from kernel.org kernel:

SDK shell session

$ cd ~/ bl uegi ga- sdk

! $ source init-sdk-env

$ bitbake linux -c nmenuconfig
. $ bitbake linux -c devshell

New devshell console window will appear:

SDK shell session

. $ cp .config
!~/ bl uegi ga- sdk/ net a/ bl uegi ga- bsp/ reci pes-kernel /i nux/|inux-3. 2/ apx4devki t / def co(:
exit :

..............................................................................................................................................................................

5.2 Compiling kernel

SDK shell session

$ cd ~/ bl uegi ga- sdk
. $ source init-sdk-env
i $ bitbake Iinux

..............................................................................................................................................................................

5.3 Building external kernel module

Build strategy differs from a module to module as it depends how it is meant to be build. Please refer to
instructions found inside the package and apply those to the SDK.

We provide very simple hello world kernel module example under

~/bluegiga-sdk/meta/bluegiga-examples/recipes/hellokernel. Please take a look to files under that directory and
modify those to your needs. Source code of the module is under the files directory.
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6 Modifying the software to support your own motherboard
6.1 Linux kernel

6.1.1 GPIO

All interfaces defined as LCD, SDIO, SAIF, UARTSs etc. in default software can be changed to be used as
GPIOs.

Following three lines are not routed to the connector.

Pin MX28_PAD_PWM3__PWM_3 is the APX4 module's LED next to power LED.

Pin MX28 PAD_GPMI_CE1N_GPIO_0_17 is reserved as Bluetooth reset and is an active low signal.
MX28_PAD_GPMI_RDY1_GPIO_0_21 is reserved as Wi-Fi reset and is also an active low signal.

Also lines for UART1, MMC2 and FECO are reserved for specific purposes and are not routed to the module's

connector.

arch/arm/mach-mxs/mach-apx4devkit.c

static const
/* LED */
MX28_PAD PWVB__PWM 3 |
/* LCD Backlight */
MX28_PAD PWW4__ PWM 4 |

i onux_cfg_t apx4devkit_pads[]

__initconst = {

MXS_PAD CTRL,

MXS_PAD CTRL,

/[* GPIO */

MX28_PAD GPM _CEIN__GPIO 0_17 | MXS_PAD CTRL, /* Bluetooth reset (active |ow)
*/

MX28_PAD GPM _RDY1__GPIO 0 21 | MXS_PAD CTRL, /* Wfi reset (active low */
MX28_PAD LCD RESET__GPIO 3_30 | MXS_PAD CTRL, /* LCD reset (active low) */
MX28_PAD SAIFO_MCLK _GPIO 3 20 | MXS_PAD CTRL, /* USB reset (active low) */
MX28_PAD JTAG RTCK __GPIO 4 20 | MXS_PAD CTRL, /* Factory reset button (active
low) */

/* MXSFB */

#define LCD_MODE (MXS_PAD 3V3 | MXS_PAD 4MA)

MX28_PAD LCD DOO__LCD DO | LCD MODE,

MX28_PAD LCD DO1_ LCD D1 | LCD_MODE,

MX28_PAD LCD D02__ LCD D2 | LCD MODE,

MX28_PAD LCD D03__LCD D3 | LCD_MODE,

MX28_PAD LCD D04 LCD D4 | LCD_MODE,

MX28_PAD LCD DO5_LCD D5 | LCD MODE,

MX28_PAD LCD D06 LCD D6 | LCD MODE,

MX28_PAD LCD DO7__LCD D7 | LCD MODE,

MX28_PAD_LCD D08__LCD D8 | LCD_MODE,

MX28_PAD LCD D09 LCD D9 | LCD MODE,

MX28_PAD LCD D10__LCD D10 | LCD MODE,

MX28_PAD LCD D11__LCD D11 | LCD MODE,

MX28_ PAD LCD D12 LCD D12 | LCD MODE,

MX28_ PAD LCD D13 LCD D13 | LCD_MODE,

MX28_PAD LCD D14__LCD D14 | LCD_MODE,

MX28_PAD LCD D15 LCD D15 | LCD MODE,

MX28_PAD LCD D16__LCD D16 | LCD_MODE,

MX28_PAD LCD D17__LCD D17 | LCD_MODE,

MX28_PAD LCD D18__ LCD D18 | LCD_MODE,

MX28_PAD LCD D19 LCD D19 | LCD MODE,

MX28_PAD LCD D20__LCD D20 | LCD_MODE,
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MX28_PAD_LCD D21 LCD D21 | LCD MODE,
MX28_PAD LCD D22_ LCD D22 | LCD_MODE,
MX28_PAD_LCD D23 LCD D23 | LCD_MODE,
MX28_PAD LCD RD E_ LCD VSYNC | LCD_MODE,
MX28_PAD_LCD WR RWN__LCD HSYNC | LCD_MODE,
MX28_PAD_LCD RS LCD DOTCLK | LCD_MODE,
MX28_PAD LCD CS__LCD ENABLE | LCD_MODE,

/ * DUART */
MX28_PAD_PWML__DUART TX | MXS_PAD_CTRL,
MX28_PAD_PWWD__DUART RX | MXS_PAD CTRL,

/* UARTO */
MX28_PAD_AUARTO_TX__AUARTO_TX,
MX28_PAD_AUARTO_RX__AUARTO_RX,
MX28_PAD_AUARTO_CTS__AUARTO_CTS,
MX28_PAD_AUARTO_RTS__AUARTO_RTS,

/* UART1 (Bl uetooth) */
MX28 PAD AUART1 _TX_ AUART1_TX,
MX28_PAD AUART1_RX _AUART1_RX,

/* UART2 */
MX28_PAD_SSP2_MOSI __ AUART2_TX,
MX28_PAD_SSP2_SCK__AUART2_RX,

/* UART3 */
MX28_PAD SSP2_SSO__AUART3_TX,
MX28_PAD_SSP2_M SO__AUART3_RX,

/* 12C */
MX28_PAD_| 200_SCL__| 2C0_SCL,
MX28_PAD_| 200_SDA | 2C0_SDA,

/* MVCO */

MX28_PAD_SSPO_DATAO__SSPO_DO |

(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATAL1__SSPO DI |

(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATA2__SSPO_D2 |

(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATA3__SSPO_D3 |

(MXS_PAD 8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_CMD__SSPO_CMD |

(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DETECT _SSPO_CARD DETECT |
(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD NOPULL),
MX28_PAD_SSPO_SCK__SSP0_SCK |

(MXS_PAD_12MA | MXS_PAD 3V3 | MXS_PAD NOPULL),

[* MMC2 (WFi) */
MX28_PAD_SSPO_DATA4__SSP2_DO |

(MXS_PAD 8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD SSP2_SS1__ SSP2 D1 |

(MXS_PAD 8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD SSP2_SS2_ SSP2_D? |

(MXS_PAD 8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATA5__SSP2_D3 |

(MXS_PAD 8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATA6__SSP2_CMD |
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(MXS_PAD_8MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SSPO_DATA7__SSP2_SCK |
(MXS_PAD_12MA | MXS_PAD 3V3 | MXS_PAD NOPULL),

#defi ne MXS_PAD FEC (MXS_PAD 8MA | MXS PAD 3V3 | MXS_PAD PULLUP)
/* fecO */

MX28_PAD _ENETO_MDC__ENETO_MDC | MXS_PAD FEC,
MX28 PAD ENETO_MDI O _ENETO_MDI O | MXS_PAD FEC,
MX28 PAD ENETO_RX EN ENETO_RX EN | MXS_PAD FEC,
MX28 PAD ENETO_RXDO__ENETO_RXDO | MXS_PAD FEC,
MX28 PAD ENETO_RXD1__ENETO _RXD1 | MXS_PAD FEC,
MX28 PAD ENETO_TX EN_ENETO_TX EN | MXS_PAD FEC,
MX28 PAD ENETO_TXDO__ENETO_TXDO | MXS_PAD FEC,
MX28_PAD ENETO_TXD1__ENETO_TXD1 | MXS_PAD FEC,
MX28 PAD ENET_CLK _CLKCTRL_ENET | MXS_PAD FEC,

/* saifO & saifl */
MX28_PAD SAI FO_LRCLK _SAI FO_LRCLK |

(MXS_PAD 12MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SAI FO_BI TCLK __SAI FO_BI TCLK |

(MXS_PAD 12MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28_PAD_SAl FO_SDATAO__SAI FO_SDATAO |

(MXS_PAD 12NMA | MXS_PAD 3V3 | MXS_PAD PULLUP),
MX28 PAD SAI F1_SDATAO__SAl F1_SDATAO |
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(MXS_PAD 12MA | MXS_PAD 3V3 | MXS_PAD PULLUP),
}s

6.1.2 12C

I2C (pins MX28_PAD_I2C0_SCL_I2C0_SCL and MX28_PAD_I2C0_SDA_I2C0_SDA) are used for RTC on the
module. On the APX4 Development Kit also SGTL5000 audio codec is also connected to it. I2C is a shared bus
so you don't need to change pin assigments. Just add your devices to the list below:

arch/arm/mach-mxs/mach-apx4devkit.c

static struct i2c_board_i nfo apx4devkit _i2c_boardinfo[] __initdata = {
{ 12C_BOARD | NFQ("sgt| 5000", 0x0a) }, /* ASoC */
{ 12C_BOARD | NFQ("pcf8563", 0x51) }, /* RTC */

..............................................................................................................................................................................

First string is driver's 12C name. In this case "pcf8563" comes from drivers/rtc/rtc-pcf8563.c. 0x51 is device's 12C
address. Please refer to 12C device's datasheet for that one.
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7 Eclipse support

7.1 Setting up the development environment

This section describes how to install and configure the Bluegiga SDK and Eclipse IDE.

7.1.1 Step 1 - Install the Bluegiga SDK

If you have Bluegiga SDK already installed, you may skip this step.

Please follow the installation instructions found in the "Getting started" section.

7.1.2 Step 2 - Prepare IDE support

Enable IDE support in the Bluegiga SDK by issuing the following commands:

$ cd ~/ bl uegi ga- sdk
$ source init-sdk-env
$ bitbake neta-ide-support

7.1.3 Step 3 - Install the Eclipse Juno IDE

If you already have the Eclipse Juno (4.2) IDE installed on your system, you may skip this step.

Download the Eclipse Juno (4.2) tarball: from http://www.eclipse.org/downloads choose the Eclipse Classic
version. Once you have the tarball downloaded, extract it into your home directory. For example, if you
downloaded it into ~/Downloads, executing the following commands will extract the content of the tarball into

~/eclipse.

$ cd ~
$ tar xvf ~/ Downl oads/eclipse-SDK-4.2*-]inux-gtk*.tar.gz

7.1.4 Step 4 - Install required plugins

First you need to install official Eclipse plugins which are required for building, executing and debugging
applications in APx4. You may do so by following the steps below:

1. Start the Eclipse IDE using commands "cd ~/eclipse” and "./eclipse". Make sure you have Java installed
by using the command "java -version". In case you need to install Java, use for example the command
"sudo apt-get install openjdk-7-jre-headless” has suggested by the output of the "java -version" command.

2. Select a workspace.

3. From the "Help" menu, select "Install New Software".

4. Select _"Juno - http://download.eclipse.org/releases/juno”_ from the "Work with" drop-down list.

5. Expand the "Linux Tools" entry when it is retrieved form the internet and select (checkbox) the "LTTng -
Linux Tracing Toolkit" box.

6. Expand the "Mobile and Device Development" entry and check the following boxes:

® "C/C++ Remote Launch”
* "Remote System Explorer End-user Runtime"
® "Remote System Explorer User Actions”
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® "Target Management Terminal"

® "TCF Remote System Explorer add-in"

® "TCF Target Explorer”
7. Expand the "Programming Languages" entry and select the "Autotools Support for CDT" box.
8. Clik "Next" buttons and complete the installation.
9. Restart the Eclipse IDE.

In addition to the standard plugins, a Yocto plugin needs to be installed. It streamlines the configuration of the
cross-compiling toolchain. Next steps explain how to install the plugin:

Start up the Eclipse IDE and select the workspace.

From the "Help" menu, select "Install New Software".

Click "Add..." in the "Work with" area.

Enter "Yocto" in the "Name" field and _"http://downloads.yoctoproject.org/releases/eclipse-plugin/1.3"_in
the URL field, and click OK.

5. Mak sure _"Yocto - http://downloads.yoctoproject.org/releases/eclipse-plugin/1.3"_is selected in the
"Work with" drop-down list.

Check the box next to "Development tools & SDKSs for Yocto Linux".

Complete the installation (discarding any message about software containing unsigned content) and
restart the Eclipse IDE.
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7.1.5 Step 5 - Configure the Eclipse Yocto Plugin

The last step in settings up the development environment is to configure the cross-compiler and target options to
be used in the Yocto plugin. These options will become the default settings for new projects.

Start up the Eclipse IDE and select the workspace.
From the "Window" menu, select "Preferences".
Select "Yocto Project ADT" from the list on the left side of the preferences dialog box.
Configure the "Cross Compiler Options" section as follows:
a. Make sure that "Build system derived toolchain" is selected.
b. Enter the path to the build directory inside the Bluegiga SDK root into the "Toolchain Root
Location" field.
c. Enter the path to the build/tmp/sysroots/apx4devkit directory inside the Bluegiga SDK root into the
"Sysroot Location" field.
d. Make sure "armv5te-bluegiga-linux-gnueabi” is selected from the "Target Architecture" drop-down
list.
5. Configure the "Target Options" section as follows:
a. Make sure that "External HW" is selected.
6. Click the OK button.

ponNE

7.2 Creating a new project

This section describes how to create a new Autotools-based project within the Eclipse IDE.

1. Start up the Eclipse IDE and select the workspace.

2. Select "File" -> "New" -> "Project".

3. Expand the "C/C++" entry and double-click "C Project".

4. Put the name of your project into the "Project name" field (do not use "-" character).

5. Expand the "Yocto Project ADT Project" and select "Hello World ANSI C Autotools Project".

6. Click "Next".

7. Add information in the "Author", "Copyright notice" and "License" fields.

8. Click "Finish".

9. If the "Open Associated Perspective" prompt appears, click "Yes" to get into the C/C++ perspective.
10. You can access your project files using the navigtion pane on the left-hand side of the screen.

7.3 Building and deploying the project
First you should build your project to make sure that it is syntactically correct.

1. Make sure that your project is selected in the left-hand side navigation pane.
2. From the "Project" menu, select "Build Project".
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If the building succeeds, you may proceed to configure the remote system where you want the program to be
copied to and executed.

From the "Run" menu, select "Run Configurations..."
Select "C/C++ Remote Application” and click the "New" icon in the top row of the dialog.
In the "Connection" area, click "New..."
Select "SSH Only" as the remote system type and click "Next".
Insert the IP address of your APx4 development kit into the "Host name" field, and click "Finish".
In the "C/C++ Application" area, click "Search Project".
Double click on the binary file in the "Binaries" list.
Insert path and name of the executable, according to how you want it to be copied to the remote system,
into the "Remote Absolute File Path for C/C++ Application” field, e.g. "/usr/bin/helloworld".
9. Click "Run".
10. Insert your username and password for the APx4 into the corresponding fields.
11. Click "OK".
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You should see the output of the program in the bottom of the screen in the "Console" tab. If you modify your
application and want to see the changes in effect, it is enough to click on the menubar "Run" -> "Run History"
and click on the first item in the list: the project will be built again and executable sent to remote device.

7.4 Debugging the project

In order to debug the project, you need to install the gdbserver package on the remote system. Log in to the
remote system as root and issue the following command:

$ opkg update
$ opkg install gdbserver

From the "Run" menu, select "Debug Configurations".

The run configuration you created previously should be selected on the list on the left-hand side of the
window.

Select the "Debugger" tab.

Put "arm-bluegiga-linux-gnueabi-gdb" into the "GDB debugger" field.

Click "Debug".

If the "Open Associated Perspective" prompt appears, click "Yes" to get into the debug perspective.

N
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The debug perspective should open up and show the first line of the main function of your application. The next
time you want to debug your application, it is enough to click on the menubar "Run" -> "Debug History" and click
on the first item in the list.
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8 Contact information

Sales: sales@bluegiga.com

Technical support: support@bluegiga.com

http://techforum.bluegiga.com

Orders: orders@bluegiga.com

WWW: http://www.bluegiga.com
http://www.bluegiga.hk

Head Office / Finland: Phone: +358-9-4355 060
Fax: +358-9-4355 0660
Sinikalliontie 5 A
02630 ESPOO
FINLAND

Head address / Finland: P.O. Box 120
02631 ESPOO
FINLAND

Sales Office / USA: Phone: +1 770 291 2181
Fax: +1 770 291 2183
Bluegiga Technologies, Inc.
3235 Satellite Boulevard, Building 400, Suite 300
Duluth, GA, 30096, USA

Sales Office / Hong-Kong: Phone: +852 3182 7321
Fax: +852 3972 5777
Bluegiga Technologies, Inc.
Unit 10-18, 32/F, Tower 1, Millennium City 1,
388 Kwun Tong Road, Kwun Tong, Kowloon,

Hong Kong
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